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New features 

 Throughout this user guide, any new feature introduced in ADaM 2011 is marked with a gold star as shown. 

Licensing 
If you have purchased a software licence then you will be given a licence key that allows you to 
process Learner and Employer Responsive ILR XML data files from different academic years for your 
organisation. Without a software licence or key file, ADaM can be run in demo mode. 

Licence key file 

The licence key file is a text file key.txt that is normally sent by email. Your licence is simple to install 
in one of several ways: 
 

• Save the key file sent as an email attachment to the folder on your computer where ADaM is 
installed. 

• Use the link shown on the Demo mode wizard screen to select and install a key file. 

Demo mode 

 
 
Demo mode allows you to experience the functionality of the software in full except that it will 
produce just a single report and will not allow you to access the In-depth ILR record and field 
changes screen. 
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Registration 

 
 
In order to use ADaM in demo mode we ask that you register your copy of the software by providing 
us with some basic information about yourself and your organisation. Please fill in all the fields.  If 
you wish to view our policy on collecting this data then please click the on screen link to View our 
privacy policy. 

Using the ADaM wizard 
The wizard is shown every time the software is used and is designed to make ILR data file selection, 
analysis and reporting as simple and fast as possible.  
 

 
It is now even easier as it is possible to jump backwards to a previous screen in the wizard without having to re-
select all of the options. Just click the corresponding tab at the top of the page to view that screen. 
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Welcome 

 
 
The welcome screen allows you to select whether to import and analyse new data or (if you have 
previously imported and saved data) view and work with a pre-existing dataset. Note you must still 
have a valid licence file in order to view this data outside of demo mode. 
 
Software version information is also shown. Updates are checked for automatically each time the 
software is started. If this fails (for example, there is no internet connection or a proxy server 
prevents connection) then the text ’Unable to connect. Your software may need updating.’ will be 
displayed. In this case we recommended that you go online and check manually if you have not used 
the software for some time. 
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Import and analyse new data 

Import mode 

 
 
When importing new data, the wizard settings screen offers 2 options, each offering a different path 
through the wizard: 
 

µDefault The simplest, fastest way to get results. Requires minimal intervention. 

Customised A more complex way to get results. Many additional options are available. 
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The wizard stages shown by each option are: 
 

Licensed uDemo mode 
Stage 

µDefault  Customised  µDefault  Customised  

Select files ü ü ü ü 

LARA selection* ü ü ü ü 

In-depth ILR record and field changes û ü û ü 

Matching  fields û ü û ü 

Report selection û ü û û 

Funded provision filter û ü û ü 

Young people filter û ü û ü 

Export folder û ü û ü 

Import and process ü ü ü ü 

Finished ü ü ü ü 

 
*This stage is skipped by default, if a LARA database has already been imported. 

Select files 

 
 
Select 2 single ILR files in XML format from the same provider and academic year. 
 

 
To make file selection even easier, it is now possible to simply drag and drop files onto the file selection wizard 
screen. Alternatively, if they are located in the same directory, you can select both files at once in the normal way. 
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The order in which the files are selected does not matter.  The earlier (1 of 2) and later (2 of 2) file 
processing sequence is determined automatically or can be set manually by specifying the ILR return. 
 

Using this method …  Processing sequence is determined by … 

Automatic Transmission number and if this is the same then the file preparation date in the XML file 
header are used. If both of these are the same then an error occurs. 
 
Note 
Automatic determination uses the file preparation date when generating report DM2b Existence: 
Enrolment missing from earlier ILR which should have been present and therefore may give 
inaccurate results. 

Manual Census date of the return selected from the dropdown lists. If both of these are the same then 
the automatic processing sequence rules are followed. 
 
Note 
Manual selection uses the census date of the selected returns when generating report DM2b 
Existence: Enrolment missing from earlier ILR which should have been present and ensures that 
this report contains only those learners who should have been present at the census date. 
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Learning Aim Reference Application (LARA) selection  

 

In previous versions of ADaM where the Learning Aim Database (LAD) was used this data was included within the 
application.  It is now be much easier to keep up to date simply by downloading the latest LARA as and when 
required.  Keeping the LARA database up to date will ensure that reports are accurate. 

 

 
 
If it is the first time you have run this application then you will need to select a valid LARA database. 
The LARA database can be downloaded via the Data Service website.   
 
If you have already recently imported a LARA database as part of a previous import then you can skip 
this by ensuring the Update LARA data check box is not selected. Otherwise use the file selection 
button to browse to the LARA database. 
 
Like the Select files screen you can select the LARA database by drag and drop onto the wizard. 
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In-depth ILR record and field changes 

 
 
Select this option to compare and see changes within individual learner and learning delivery 
elements between the 2 ILR files selected (recommended).  If you do not run this then there will be 
no changes listed and the option to view the In-depth ILR record and field changes would be disabled. 
 
After selecting In-depth ILR record and field changes you can choose which fields to compare. 
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The funding only option includes the ILR elements that may impact on funding: 
 
ADaM table ADaM field ILR description ILR entity 

Learner ALSCost Additional learning support cost Learner 

Learner DateOfBirth Date Of Birth Learner 

Learner DisUpFact Disadvantage uplift factor Learner 

Learner PriorAttain Prior Attainment Value Learner 

Learner DUE Disadvantage Uplift Eligibility Learner FAM 

Learner EFE Eligibility for 16-18 funding entitlement Learner FAM 

Learning Delivery CompStatus Completion status Learning Delivery 

Learning Delivery DelMode Delivery mode Learning Delivery 

Learning Delivery DistLearnSLN Distance learning SLN Learning Delivery 

Learning Delivery FundModel  Funding model Learning Delivery 

Learning Delivery GLH Guided learning hours Learning Delivery 

Learning Delivery LearnActEndDate Learning actual end date Learning Delivery 

Learning Delivery LearnAimRef Learning aim reference Learning Delivery 

Learning Delivery LearnPlanEndDate Learning planned end date Learning Delivery 

Learning Delivery LearnStartDate Learning start date Learning Delivery 

Learning Delivery MainDelMeth Main delivery method Learning Delivery 

Learning Delivery OutcomeInd Outcome indicator Learning Delivery 

Learning Delivery ProgType Program Type Learning Delivery 

Learning Delivery ProdFundRemain Proportion of funding remaining Learning Delivery 

Learning Delivery WithdrawReason Reason for Withdrawal Learning Delivery 

Learning Delivery FeeYTD Tuition Fees Received Year To Date Learning Delivery 

Learning Delivery FFI Fully Funded Indicator Learning Delivery FAM 

Learning Delivery EEF Eligibility for enhanced ER funding Learning Delivery FAM 

Learning Delivery RET Re-take Indicator Learning Delivery FAM 

Learning Delivery SOF Source of funding * Learning Delivery FAM 

Learning Delivery SOF2 Source of funding* Learning Delivery FAM 

 
*Multiple XML element occurrences within ILR file. 

 
µIf you chose the default settings then In-depth ILR record and field change are performed on 
funding fields only. 
 

 
Selecting everything will not just include fields from the Learning Delivery entity but will also include fields from 
the Learner entity too. 
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The user defined option allows you to 
select which fields to compare. The 
fields are grouped by the ADaM table to 
which they belong to (Learner and 
Learning Delivery). 
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Matching ILR fields 

 
 
When comparing the 2 ILR XML files, ADaM needs to know how to compare the data within the 
Learning Delivery entity. 
 
Learner reference will always be consistent but the Aim Sequence number for individual enrolments 
may not be consistent between the ILR files, so they cannot be matched on this field. This is 
especially true when enrolments have been added or removed. Therefore, a combination of 1 or 
more of the following fields needs to be used (in addition to learner reference) to provide a common 
link between the 2 ILR files:  
 

• Learning Aim reference 
• Learning Delivery provider specified monitoring A 
• Learning Delivery provider specified monitoring B 
• Learning Delivery provider specified monitoring C 
• Learning Delivery provider specified monitoring D 

 
µIf you chose default settings mode then only learning aim reference is selected automatically. 
 
In some circumstances it may be beneficial to match on Learning Delivery provider specified 
monitoring fields instead of on the learning aim reference. Possible benefits include: 
 

• Highlighting of changes to the learning aim reference. 
• Removal of changes to learning aim reference appearing as apparent errors in standard 

reports 
• Removal of possible apparent duplicates in standard reports where a learner is enrolled to 

the same learning aim reference more than once.  
 

 
If there are any duplicates found then these are shown on the reports as well on the In-depth ILR record and field 
changes screen. 

 
For further information on duplicates, please see the Frequently Asked Questions (FAQs) section of 
the user guide. 

http://www.drakelane.co.uk


 

ADaM 2011 user guide - 14 - www.drakelane.co.uk
  

Report selection 

 
 
Select which reports you are interested in and the output format that you require for each by ticking 
the relevant boxes in the grid. You can also use the buttons at the top right hand side of the screen 
to select all reports of a particular type. 
 

 
Even if you do not choose to export any reports you can still view and export them from the View menu at the top 
of the screen. 

 

PDF (Portable Document Format) XLS (Microsoft Excel) 

 Useful for printing but has fewer fields shown because 
of space restrictions. 

 Useful for further analysis with many additional 
fields shown. 

 
µIf you chose default settings mode then all reports in all formats are generated automatically. 
 
uDemo mode produces a single report (DM2a) in all formats and this wizard stage is not shown. You 
will also not be able to access the other reports from the menu. 
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Funded provision filter 

 
 
Select whether or not to report only FE funded provision (where appropriate). 
 
µIf you chose default settings mode then report only FE funded provision is selected automatically. 

Young People filter 

 
 
Use this to include only learners of a specific age group in the reports. Learner age is as at 31st 
August of the ILR file academic year.  
 
µIf you chose default settings mode then this will default to reporting on all learners. 
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Export folder 

 
 
Select a folder to place the exported report files in. 
 
µIf you chose default settings mode then a new folder named ‘exports\YYYYMMDD’ (Year, Month, 
Day) is created in installation folder.  
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Import and process 

 
 
The Next button will begin importing/processing. Note, the produce detailed logging check box 
should only be used if you have experienced an error message for some reason. This detailed log file 
will give us a lot more information with what to help you with. 
 

 
 
A progress indicator is shown giving an estimate of the % processing complete and the task currently 
being undertaken. The time taken to process the ILR data will depend upon your computer 
specification, the size of the ILR files and (in customised settings mode) the specific settings chosen 
and tasks requested.  
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Finished 

 
 
Once processing has completed successfully, several options are normally available: 
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Open report 
export folder 

Opens the folder where PDF and XLS report outputs have been 
placed. If you chose customised settings mode but selected none of 
the outputs then this button is unavailable. However, you will still be 
able to view them from the View menu. 
 
Not available when looking at previous datasets. 

 
View in-depth ILR 
record and field 
changes 

Opens the on-screen viewer for XML ILR record and fields changes. If 
you chose customised settings mode but selected not to perform an 
in-depth field change comparison then this button is unavailable. 
 
uDemo mode only summarises record and field change data and 
this button is unavailable. 

 
View process log Opens the ADaM processing log (located in [InstallDirectory]\Logs) 

which shows detailed information about what tasks have been 
performed and long it took to perform each. 
 
Not available when looking at previous datasets. 

 
Save current 
database 

Saves a copy of the complete SQL database so that it can be referred 
to later. This data also includes the results of the in-depth ILR record 
and field changes. 
 
Not available when looking at previous datasets. 

 
Run wizard Run the wizard again from the beginning or from part way through 

with different options for in-depth ILR record and field changes. 

 Finish Close the wizard and optionally exit ADaM. 
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View and work with previously imported data 

Previous data 

 
 
Select a previous data import that you have saved from the list provided and press Next. This will 
allow you to view the reports and the in-depth ILR record and field changes without having to re-
import the ILR XML files. Please note you will still need to have a valid licence for the data selected. 

Finished 

The finished screen will look as it during a standard import with the following exceptions: 
 

 
Open report 
export folder 

Will not be available so you will not be able to see the reports 
in the exported folder, though the reports them selves will still 
exist provided you have not done any further imports for that 
day. You can still view and re-export the reports for this 
previous data by selecting the report from the View menu at 
the top of the screen. 

 
View process log Will not be available as there has been no import, though as 

with the reports the file it self will still be available provided 
there had been no subsequent reports that day. 

 
Save current 
database 

Will not be available as we are already looking at a previous 
database. 

 
Run wizard Is available but only from the beginning. It will not import to 

and overwrite the previous database (the previous database is 
for reviewing purposes only). 
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Standard menus 

 
Standard windows menus (with the exception of the Help menu items) are a new feature. They allow you to jump 
in at various points within the wizard and provide you with the option of viewing the reports directly. 

 

Menu text Description 

File  

 Import new data Start the wizard from the beginning allowing you to select new XML ILR files. 

 Load previous data Start the wizard on the previous data screen allowing you to select a previously 
saved dataset to view. 

  Re-calculate reports 
Start the wizard from part way through with different options for in-depth ILR 
record and field changes. 

  Export to Microsoft Access 
Save the entire database to Microsoft Access so you can perform your own 
analysis on that data. 

  Save a database copy 
Saves a copy of the complete SQL database (if you have already performed an 
Import) so that it can be referred to later. 

 Exit Exit the application 

View  

  Report - DM1, DM2a… 
Runs the relevant report and shows the data on screen, where it can be printed, 
viewed or exported. 

 Exported reports Opens the latest folder containing the exported reports.  

 In-depth ILR record and 
field changes 

Opens the In-depth ILR record and field changes (also accessible from the last page 
of the wizard). 

 Today’s process log Views the log for the last import if any imports have been done today. 

Help  

 User guide Opens this user guide. 

 Drake Lane Associates 
website 

Go to our website at www.drakelane.co.uk 

 E-mail 
support@drakelane.co.uk 

Send an e-mail to support@drakelane.co.uk 

  About 
Gives information about the application, including the application’s version 
number. 

Window 

 [1 Screen 1], [2 Screen 2]… Displays the selected screen on top if there is more than one screen open. 

http://www.drakelane.co.uk
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About report exports 
The standard reports come in 2 formats, PDF (Portable Document Format) and XLS (Microsoft Excel). 
 

PDF (Portable Document Format) XLS (Microsoft Excel) 

 Useful for printing but has fewer fields shown because 
of space restrictions. 

 Useful for further analysis with many additional 
fields shown. 

 
Each report is output to the selected folder and named ID.EXT where ID is the report ID (e.g. DM1), 
and EXT is the file format extension (PDF or XLS). 

PDF (Portable Document Format) 

Header information 

The first 3 pages of each of the reports show summary information; any text that is grey represents 
the results from when the report was previously compiled, not necessarily from the same import file. 
 
Below details each section of the report: 
 

Section Information Shows 

Title The report ID and title. 

Description A detailed description of what this report investigates. 

Impact The possible impact of data appearing on this report. 

Action The suggested actions to take. 

Page header 

Other Any other notes. 

Issue The report ID and title. The current report is highlighted. 

Funded only? Ticked if the report was looking at funded data only 

Learner age Shows if and what learner age filters where used 

Absolute The number of records in the report. 

Proportion (%) The number of records in the report as a % of the total number of FE 
funded aim records within the earliest ILR file (file 1 of 2). This provides 
an indication of the relative scale of each issue. 

Record counts 

Relative A visual indicator of the relative scale of each issue. 

Earlier file (1 of 2) Information about the earliest ILR file. 
Files processed 

Later file (2 of 2) Information about the latest ILR file. 

Field The ILR field (element). Only fields where a change has been found are 
reported. 

Field change 
counts 

Absolute The number of changes. 
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Section Information Shows 

Proportion The number of changes as a % of the total number of changes. This 
provides an indication of the relative scale of each field change. 

Relative A visual indicator of the relative scale of each field change. 

Aim code The learning aim code that appears in the reports 

Learning aim title The learning aim title according to LARA. 

Occurrences The number of times this learning aim appears in the report. 

Proportion The number of times the learning aim appears as a % of the total number 
of records on the report. 

 
 
Learning aim 
occurrences 

Relative A visual indicator of the proportion of the total times this learning aim 
occurs on the report. 

Title The report ID and title. 

Email The support email address. 

Date stamp Time and date the report was produced. 

Demo Demo mode indicator (as appropriate). 

Version Software version. 

Page The page number. 

UKPRN The UK provider reference number. 

Page footer 

Provider name The provider name. 

 

http://www.drakelane.co.uk


 

ADaM 2011 user guide - 24 - www.drakelane.co.uk
  

Comparisons and performance indicators 

For the absolute and proportion (%) record counts, ‘traffic light’ performance indicators are shown in 
colour: 
 

Indicator Meaning 

n The record count value has increased. 

n The record count value is the same (except where both are zero). 

n The record count value has decreased. 

Data detail 

The other pages that follow show the detailed record information for the particular report. The 
default sort order is by the Learning aim with the most occurrences first. As the report is grouped by 
learning aim reference it is shown only once. 

XLS (Microsoft Excel) 

Only the detailed record information is output in this format, but with many more fields than are 
available in the printed or PDF format. In addition to standard ILR fields, others may be shown 
depending on the specific report; for example, those relating to the learning aim (e.g. Notional NVQ 
Level) or calculated fields (e.g. Expected Duration in days).   
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Viewing reports on screen 

 

You can now view the reports on screen. Not only can you preview the PDF document 
but you can also view the data that is exported to Excel in a user-friendly grid by clicking 
on the data grid tab. 

 

Preview 

 

Option Icon Option Description 

 
Navigation Go to the selected page. You can navigate by either 

using the buttons to go to the first, go back, go 
forward or go to the last page. You can also go directly 
to a page by entering the page number in the box. 

 
Cancel rendering and refresh Stop the report rendering on screen before it is 

finished or render again using the refresh button. 

 
Print Opens a print dialog allowing you to print the whole 

report or just a selection of pages. 

 
Print layout Show the report as it would appear on paper with your 

current print settings. This option is turned on by 
default. 

 
Page setup Adjust the page margins and paper size for your 

printer. 

 
Export Export the selected report Excel, PDF or Word. 

Note: If you select Excel or Word, the exported data is 
the report shown on the Preview tab and not the data 
grid. Use the Excel export button on the Data grid tab 
if you want the detailed breakdown. 

 
Zoom Zoom in or out of the preview. 
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Data grid 

 
This shows a detailed breakdown of the report in a grid. With this grid you can: 
 

• Group by a particular field. For example: If you wanted to see how many learners come 
under a particular funding model, then just drag the funding model column header to the top 
of the grid. 

• Sort on any field that you want, by simply clicking the column header. 
• Re-arrange columns by drag and dropping. 
• Filter the selection by any column by entering the text you want to filter by on the top row 

of the grid. 
• Hide/Show columns by pressing the button at the top left hand side of the grid, the columns 

selected will be reflected on the export. 
• Summarise columns by clicking Σ symbol at the top of numeric columns. This will show you 

the average, count, maximum, minimum and sum of that column (though in some cases 
some of these functions may not be appropriate for the column). 

 

 
Click the Excel button to export the grid with your formatting and filter changes to Excel for 
further processing. 
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Examining in-depth ILR record and field changes 

Available from the Finished wizard stage or from the menu, this on-screen viewer displays all Learner 
and Learning Delivery dataset records from the first ILR which have changes in the second ILR. Only 
those records with changes in the fields chosen for comparison are shown.  
 

 
Data can be exported to Excel on a learner by learner basis or as a whole using the relevant on screen buttons. 

 
u Demo mode only summarises record and field change data, so this screen is therefore unavailable. 

How are records compared? 

Learner records are compared using the Learner reference number field to tie the two together. 
Learning Delivery (Aim records) are compared based on the fields chosen in the Matching fields 
wizard stage.  

What fields are compared? 

The fields compared within each record are those chosen in the In-depth ILR record and field changes 
wizard stage. 

What am I looking at on screen? 

 
 
 
 
 

 
å 

 
 
 

ç 

 

é         è 
ê 
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Original records 

These are all of the Learner and Learning Delivery records from the earlier ILR 
file (file 1 of 2 on the report exports) where there is a changed record either on 
the Learner and/or a Learning Delivery record belonging to that Learner. Each 
Learner record in the top grid can be expanded to show the Learning Delivery 
details by clicking the small + (plus) button on the left of the row. 
 
Clicking on the Learner will show all the changes for that Learner in the 
changed records grid (2). Clicking on the Learning Delivery will show changes 
for the selected Learning Delivery record. Records are matched based on the 
selections you made in the Matching fields screen of the wizard. 
 
You can drag-and-drop column headings to different positions as required and 
adjust the column widths 

You can now group the columns on the Learner. 
 
You can sort the columns in both Learner and Learning Delivery. Sorting Learning 
Delivery will apply that sort to the Changed records too. 
 
You can use the top row of the grid to filter Learner data. 

å 

 

 
Use to select which columns that you wish to show/hide, this selection will be 
applied to both grids. 

Changed records 

These are the learner and Learning Delivery records from the later ILR file (file 
2 of 2 on the report exports) that match the currently selected record in the 
original record. Records are matched based on the selections you made in the 
Matching fields screen of the wizard. 
 
You can drag-and-drop column headings to different positions as required and 
adjust the column widths 

The changes are colour coded : 

Indicates that the row has changed. 

Indicates that the data in this cell has changed. 

 

Indicates that more than one record was found when matching the fields between the 
two ILR files. These duplicate records may make it appear that there are changes when 
actually there are none. You may want to change selections on the Matching fields tab of 
the wizard. 

ç 

 
You can sort the columns. 
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é Changed fields for Learner/Learning Delivery 

These are the field changes between both ILR files for the selected Learner or 
Learning Delivery. The count displays the number of times each field has 
changed for the selected record. Selecting a record cause the to focus on that 
cell. 

è Filter 

These are all the fields where there has been a change in the original records 
(1). Alongside each is a count of the number of original records with a change 
in that specific field. The fields shown will change depending on the options 
selected from the in-depth ILR record and field changes wizard stage. 
 
To filter on specific field changes, simply tick or un-tick the fields you want and 
then press Apply filter. If multiple filter fields are selected then records are 
filtered to show those where there are field changes for any of those selected 
(equivalent to the OR statement in SQL). 
 
Press reset filter to remove filters and show everything. 

Control buttons 

Select all/De-select all. Quickly tick or un-tick all the filters available in the 
filters grid. Note the filter will not be applied until you click Apply filter. 
 
Apply filter. Choose which fields to be reported on, anything not in the 
selection will not be included in the grids or the results. 
 
Reset filter. All fields will be shown as default. There is no need to click Apply 
filter. 
 
Finish. Close the screen 

 Save Learner to Excel. Requires a learner to be selected in the original 
records (1). This will be a multi-sheet Excel workbook for the selected learner 
only.  
Sheet 1 - shows the Original record (1).  
Sheet 2 - shows the Changed record (2).  
Sheet 3 - shows the Changed fields for learner (3). 

 Save all to Excel. This will be multi-sheet Excel workbook for all learners 
currently shown.  
Sheet 1 - shows the Original records (1).  
Sheet 2 - shows the Changed records (2).  
Sheet 3 - shows the Filter applied (4). 

ê 

 Save Layouts. Save any changes made to the grids such as column 
positions and ordering etc. The layout will be remembered the next time you 
run the application. 
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 Reset layouts. Reset the grids back to their default settings. You will need 
to close and re-open the screen for this to take effect. 

 Report on selected change by aim. Produces a unique report that is not 
exported as part of the wizard. The report lists the number of changes there are 
for a particular field for each Learning Aim type. In order to run this report you 
must first select the field you want to view from the Filter grid (4). The data for 
this report will come from process 1 only. 
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Export database 

As mentioned previously you can carry out your own additional analysis by exporting the database 
to Microsoft Access using the export option on the main menu. Below is a description of the tables 
that are most common or useful. 
 

Table name Table description Contains 

ProcessInformation Process Information This is data from the both ILR files (files 1 and 2 on the reports). 
When the processID field equals 0 then it is the earlier file and when 
processID field equals 1 then this is the later file. Note that there will 
be multiple lines if you have imported different files as this keeps a 
retrospective log of those imports. The current records are identified 
by CurrentRecord = 1 

ChangedFields Changes Lists all the fields that have changed. The ChangeId and the 
Tablename field provide the link to LearningDelivery or Learner 
tables where there is a change.  

 
 
ReportSummary 

Report summary Used on the first page of the reports to display what options were 
used to produce the report, the total amount of records that were 
returned for each (Absolute) and the total FE records searched 
through (TotalRecCountFe). This table will keep a log of all the 
reports run for all imports; the Index value represents a set of reports 
run. The ProcessimportID tells you which file the reports were run on 
by linking to ImportId in the Process Information table. 

FundingValues Funding values This is from the LARA. 

Learner Learner Contains all pertinent information on all Learners imported from both 
ILR files. The ProcessId indicates which file the Learner was imported 
from. Field names match the entities within the XML ILR fields, 
however some fields such as EFE are not strictly elements, but are 
possible rows contained in other nodes for example EFE is a row 
within  
Learner funding and monitoring type node under the 
LearnFAMType element. 

LearningDelivery Learning delivery Contains all the Learning Aims for all the learners within both ILR 
files. 
Other than the ProcessId, ChangeId, Changed, Matched, MatchedId 
all fields match the entities specified in the XML ILR files, though 
some may have belonged to different nodes and like the Learner 
table some columns are actually rows in the original XML ILR file. 
Unlike the ChangeId the MatchedId only indicates that the record 
was found in both files regardless if there were any changes or not. 

NVQ_Levels NVQ Levels This is from the LARA. 

MovementsFrom Movements from Shows all the records where a listed Movement from is found. A 
Learner is considered moved when the learning aim reference has 
changed from one file to the other. 

MovementsTo Movements to Shows all the records where a listed Movement to is found. A Learner 
is considered moved when the learning aim reference has changed 
from one file to the other. 

LearningAimsDesc Learning Aims descriptions This is from the LARA. 

Learning_Aim_Types Learning Aim Types This is from the LARA. 
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Frequently Asked Questions 

What action should I be considering when reviewing the reports? 

In respect of any ILR files which are now closed, the only available action would appear to be to 
review the data reported and to prepare a defence (where appropriate) for any practices which are 
felt to be justifiable. Where an ILR has not yet been closed down then it may be appropriate to make 
amendments to the data in certain cases. In terms of looking forward, it may be appropriate to 
change certain data management practices and to convey these to all appropriate staff. The new 
report accessible from the In-depth ILR record and field changes screen may help with identifying the 
relevant staff. 

How do I know what to focus my attention on when reviewing the reports? 

It is suggested that you begin by reviewing the reports with the greatest number of records 
highlighted (see the summary on the first page of each PDF output). Note that these raw record 
numbers are also compared to the total number of enrolments within the first ILR to provide an 
indication of the relative scale of each issue. Secondly, it is suggested that you focus on any patterns 
within the reports, however large or small; for example, instances of whole courses appearing on any 
given report. 

Can I find out about data changes other than those highlighted in the standard reports? 

Yes, once the wizard has completed, select the button to View In-depth ILR record and field changes 
to display all records from the earlier ILR which have changes of any sort in the later ILR. Please refer 
to this user guide for a more detailed explanation of how to use this screen. In Customised mode the 
wizard also allows you to specify what sort of ILR changes you are interested in seeing via this facility 
(e.g. funding related changes only, all changes or a user-defined selection of fields). 

How can I do further analysis on the data reported? 

All standard reports provide an output in Microsoft® Excel (XLS) format which generally include more 
information than it is possible to display in PDF format. This XLS data can easily be linked back to 
source MIS data to undertaken further analysis. In addition, we have added the ability to export to a 
Microsoft® Access database which includes all data relating to any changes between the 2 ILR files.  

Can I select individual reports to run and specify which types of output I want? 

Yes, by running the wizard in Customised rather than µDefault mode. On the wizard stage Report 
output formats you have the option selecting as many of the standard reports as you require. You 
can also specify whether you want the outputs in PDF or XLS format (or both). 

Can I compare 2 ILR XML files which have the same file name? 

Yes, by specifying the returns manually or ensuring the files have a different transmission number or 
preparation date. 

Some reports appear to show too many Learning Delivery records where a learner is enrolled to 
the same learning aim more than once. Can I prevent this? 

Yes (in many cases), by running the wizard in Customised rather than µDefault mode. On the wizard 
stage Matching fields you have the option of linking between the 2 ILR files on Learning Delivery 
provider specified monitoring fields rather than on the learning aim reference. If you use one or more 
of these fields to store the course code then linking on these is likely to remove such apparent 
duplicates (assuming that the course codes are different between the 2 enrolments with the same 
learning aim). 
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Report DM2a (Existence: Enrolment no longer appears in ILR) suggests that records have been 
removed from the ILR whereas they actually still exist but their learning aim reference has been 
changed. Can I prevent this? 

Yes (in many cases), by running the wizard in Customised rather than µDefault mode. On the wizard 
stage Matching fields you have the option of linking between the 2 ILR files on Learning Delivery 
provider specified monitoring fields rather than on the learning aim reference. If you use one or more 
of these fields to store the course code then linking on these should remove changes to learning aims 
from the report (assuming that the course code used remains consistent across the 2 ILR files). 

Report DM2b (Existence: Enrolment missing from earlier ILR which should have been present) 
suggests that records were missing from the earlier ILR whereas the learners actually started 
after the census date for the return but before the preparation date. Can I prevent this? 

Yes, by manually specifying the actual return for each file on the Select files wizard stage. This 
ensures that the reference date used for the earlier file is the return census date and not the file 
preparation date. Remember though that using the file preparation dates rather than specifying the 
returns may highlight potential internal data processing issues where there is significant lag between 
learner enrolment and inclusion in the ILR. 

The reports seem to take a long time to produce 

Try closing any other applications down when running the wizard to free up memory and processing 
power. Also consider whether you need PDF exports for every report. You can turn them off 
individually or as a whole by using the Report selection screen on the wizard in customised mode. 
You will still be able to view and then export these reports using the onscreen menus. 

Getting help 

Click here for help 
This user guide is available at any time by clicking the link shown at the bottom 
of each wizard stage. 

 

 

Alternatively, it is also available from the Help menu at 
the top of the screen along with links to our website 
www.drakelane.co.uk and our contact email 
support@drakelane.co.uk 

 

http://www.drakelane.co.uk
http://www.drakelane.co.uk
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